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MATLAB Lol cleaS5s: 5] Las

RCOR SOP PR Lo B

Command window : -k s o
Command History ol sius asss b o oy
Current Directory : ¢ > 6,65 5l 0,50
Work Space: ¢ 5 slad o,

Sl 6,88 gl
Start S 90
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MATLAB Lol cleaS5s: 5] Las

<) MATLAB -1Of x|

File Edit View Web Window Help

0O | he B oo | & ’ ? lCurrenI Direclory:IE:MATLABBpS\.work _'_I _J
Current Directory Command Wiridow 2] x|
[Ervmrimerswer %] || 61 o | 88 || Deine Tooivox Pach Cashe. Type "help coolbox_pach cache]
A1l Files IFile Type ILast. M To get started, select "MATLAB Help” from the Help menu.
[Jbouy Folder lB—Jun<|.:

(3 Carpet Folder 27-Jul-_| 2

(JCom Folder 27-Apr- .

(] fdgdg Folder 11-Jun- d LQ)3 0o ch )

() ImageCom Folder 30-Apr- u * K4

([JMatrixCom Folder 30-Apr-

P L . _—--v
| | »

—l—l' "1 ‘orkspace Current Directory |

Command History u
acfnew - I

close all

acfnew A * L‘,‘ o .
close all o ..) )'?tho
acfnew

lookfor hsv

_— k:)‘)a.:.uéd

gethsv('show') —

v
$-- 9/16/03 10:41 AM —-% _7_1 q | o
4\ Start |
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Command Window : ;L5 o o

Command Window

Using Toolbox Path Cache. Type "help toolbox_path cache”™ for more info. —
To get started, select "MATLAE Help™ from the Help menu.
7

: @
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Command History ol gius asse b o,z

Command History

close all . : -
el Sl a5 Jlygius (oolod )

actnew ) 3] 49 Mg b

lookfor hsv b asilei (oo Lol .igls (0 a3LSI

ol SISy 59y » Sels o
T 0,90 gl 2! Eels il ygiwd
gethsv('show') A g )

5-- 9/16/03 10:41 AM --%

gethsv

help toolbox path cache
== 041603 Y1 DY AN —=%
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Current DireCtory : Lg)L? 6)935):’.“3 0y

Current Directory
SO s oloy 2 0 \IE:EMTLABGpS‘swork bl _H £ \ i
Ylgae dy dlig b iS5 Wl
us-':‘: .O 9:’ ‘S;f;s);o All Files File Type Last M
Lo yo 5yl ) r
. A o “Jbouy Folder 18-Junis
J;ls ).b ég.w P sl
L ds 95 4ol )i (7 Carpet Folder 27-Jul-
Sl ol pb as (Lo bawgs (JCom Folder 27-Apr-
Lo 09 ol o Ml () fdgdy Folder 11-Jun-
A dgu (0 2| (Fyg00 0 (] ImageCon Folder 30-Apr-
2 bl e plo o (JMatrixCon Folder 30-Apr-
- - () TabMatlabCon Folderx 26—Jul-Lj
| | A
4 :
“1  Workspace Current Directory
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Work Space: ¢ 5 ¢las

o Jb o a5 o e Naﬁg Size Bytes|Class
S99 lio (6,15 bapxo o EHa \ 362x500x3| 543000 |uint8 array
. o s X
- m X ouble array
Slasly (oo Lo g wiylo 1x2 16 | doubl
b oS oolasw! Ll olis B = 10x10 500 | double array
GBS i |y L] B = 10x10 100|uint8 array

_‘I_’.l Workspace Current Directory
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ool ool Olloe-Y-)
1OHke SO dwlbre 1l
Jsl ol
>> 4*%25 + 6*%22 + 2*99 _ |
dans=
430
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ool G,ol.:) Sldos-Y-)

:‘9900‘)
>>a=25;
>>b=22; c=99;
— A X RS RS
>zci4a+6 b+2*C s e ) ai
430 [ piie iy a3 oY S
> >

s (Sl it ' 4S5
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Lo
>>572
danNs=
25

A>/\*>+-ﬁmd>w)4 =
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Work space _l ¢,5 clas-f-)

Lo plis alidl 51 5 ;0 digd o el cilie Luse )3 45 la ke
L:;,L,ow)iw‘ LSLQ d,obﬁ LS)LY Lgl..é:.é .J.So)ftsoo)pégl‘;oé)lf
o e b (0 (i ST S el LSS Ll o )5 (slad
oo 1 9 8,5 solatwl o1 5l le o oo Sl dali o SO0 il o
9A.JMo?dg&ﬁ:é:néjlfétééé‘)‘o%hﬁ@gUé&@MUﬁu‘
A dalgs ools sy ST sledad o s slo aulip glgil 5,90 0 W
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Work space il ¢,l5 glas-f-)
o pie Ll oy M
whos ;who .o B
load ;save ol jgws o ,sie Lk go s B
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MATLAB (Lol (sleaS 525 15l S

s s Lael o=V %)

25 S 59 55 5 Wigh o i 55 15 5L 45 oS ylo i
ol aiplegs S alasls
o zg> B
.Clear jgus 5l oslinsl W

>> clear Nod oo S abibl> 5l b e oled
>> clearabc aladl> 5l ond 00 el (gl yuiio Lo

Ngd oo Sk

uLng\ L;\x.ua a\i.m.\‘.l—@g.\k u.u\_xg
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whos , Who ol gue-v-f-)

S5l Cesas | ()5 (glad )0 35250 slo ite (Slasein g) oalol (g (oo j5imsn g0 ol Sl enlizul L
>> who
Your variables are:

abc
>> whos
Name Size Bytes Class
a 1x1 8 double array
b 1x1 8 double array
C 1x1 8 double array

WhOS s aisle |, 6,15 (slad 1o d9> 50 slo yuiie Slasein 55 WOFKSPACE o, w5 5lok

uL@m\ L;\x.ua btg\.m.\‘.l—@:}.\k u.uLIQ
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load ;save ol giws s i oLk g 0 053 -Y-F)

oolazwl LS‘)’. Lg)lf Lgl..é:é)o 34> 90 LSLQWJG,ML,MUJMMJ CBPJQM.:Mb;u &3,3)9.,4)0
00 0 3 o e e 0 108 j5iws b .osS o 00liiw] SAVE jgiws 5l w3 3 0,53 som sla

>>a=5; b=4; c=7;
>>save c:\myfile.mat a c;
>>clear wss o SU s s don
>>a
??? Undefined function or variable 'a'
>> |oad c:\myfile.mat
>>a

a:

5

>>b
??? Undefined function or variable 'a'

Sl 55k (6,8 slad 4

uL@Jm\ L;\x.ua bti.m.\‘.l—@g.\k u.u\_tc

s



MATLAB Lol sleFs 2 sl b

load ;save oljgius o e bk g 0 w53 -Y-¥-)

ool 55 ©,9a lOAA
save [filename] [variab

Load [filename] [variab

es]
es|

s,0o Matlab.mat 55 oy LG seas ansg LB oul a5 50,0

Wigde oLk LB o ool

uL@Jm\ L;\x.ua b&m.\\.ﬁ—@;t.\la u.u\_tc
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(Format ,g.s) sloel il cw,3-0-)
Bl e 1) Clite e yd o,y o slasl gioled o9 g8 ce ygiws ol sl eolasl b
>>Format [option]

Option: short, long, short e, long e, short g, long g, hex,
+, ...

0925 Lpid g a0 od i |y Slislowe C8o jows oplaS oS Céo
CldS sales SU slael gioles

uL@m‘ L;\a.ua bl.?\.m.\‘.l-@g.\k u.u\_u:



MATLAB Lol sleFs 2 sl b

L oz glgil -
podie )3 yeaie Elgil (p ek 3 pan
double (cobA) ielas cds b Liel abais
Struct )15 Lawg oot ciy a5 g5
single :(col f) liclaais
uint8 D A Cadle o oo Dus
uintlé e VP e o e dus:
uint32 - S YY cdle o (oo dac
uinté4 e PY Ll o (Proo suc
|nt8 L':.‘"“’A wdd&
intl6 T \Vd Tuo dae
int32 o VY s sue
|nt64 : b.’:,:,:?f st

oS ooliul help datatypes jsivs ) ol o,men o cdie glgil Lol cndd s 1y P

uL@m‘ L;\a.ua bl.?\.m.\‘.l-@g.\k u.u\_u:
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ARRAY
[ full or sparse]

logical char NUMERIC cell structure function
handle

user classes Java classes

|
1nt8, uinta, ‘
1nt16, urntisa, single double
1nt32,uint32,
int64d, uinted

uL@m‘ L;\a.ua bl.?\.m.\‘.l-@g.\k u.u\_u:



MATLAB Lol sleFs 2 sl b

o o glgil -2
(PR S £ Ll S o Slciin 1) e e 51 alises glgil s ax ST a5 0,5 Cds Wl
25 G 5 S g Wb e G g oS e g ol Taclan c8s gy
a=TypeName(a);
>> a=Uuint8(a); o5 o o S A e o o 4 piie g5 i) o
>> b = uint32(345); o fY code o oo g9 5l ol 5l e G bl o
S| 00 uz.:).x.:
C)B 0l 00l ul\M‘ )‘Aﬁ.o c\SJ..USU_eo ,)._,L,)M &_, QL?U‘ I_, J-’J-A-’ r,Lia, = (B D
e Gl e 5l ol oo puomo £loil gl ails el g4 o] polie andls
S oolawl asls

>> intmin(‘int16’)
>> intmax(‘intl16’)

Jial inia il s il
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b e (o JAKaL V-

Sii s SzsS Sy, sl B
39 g9, b Ll 8> |
9 Slacl ct_o.]‘ J9).> )l.‘>r.o LSLQJJS‘)K
Sl 2 o NAamMelengthmax b 5l colasl b :ol Jobo jiSTas
ol GS1ISFY 5STas Vo F ddud )0 090 e Wil o MATLAB
S b L MATLAB iy mb o b L ko ol <l 0
3ol (gl alls plion w‘ oo ddg led 0¢5 lawgs
oS oolal Which —all varName ..o
: JUo

>>This_Is a Variable=5;
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035 S yria=A=)
5l 9525 (B8 i D ygear e lame jo g sle e

ans NaN nargin
pi i nargout
eps ]

inf
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oo e g (g iFalads (Hle-9-)

S oolaiul %

>> a=5; %”a” is a variable
23,5 eolawl .l ol aw Jaw jo des SO dllol 2l 6l )
>> pb=ag+a”2+...

3*an3;

uL@Jm\ L;\x.ua bti.m.\‘.l—@g.\k u.u\_tc
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liss olael =Y =)

oolazul g5 o J o1 o oo yusio 5l dabises slocl cay x5 (6l

Sy
>>c=1-2i; >>k=(-1)"(1/2);
>>c=1-2j; >>c=1-2*k;
>>c=1-2%j;

:alises slacl b IS aoles
abs angle real imag

uL@Jm\ L;\x.ua bti.m.\‘.l—@g.\k u.u\_tc
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abs
acos
asin
acosh
asinh
atan
atanh

s jo ok, mlys 5l oam =1 )-)

conj log10
exp real
fix imag

round rem(x,y)
gcd(x,y) sign
lcm(x,y) sqrt

log

uL@Jm\ L;\x.ua b&m.\\.ﬁ—@;t.\la u.u\_tc
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Lo glosal ~) Y-
S &,k sl e a5 el Selate lesaly &l jgiws (ol ls e
iy B i Plel &b 5l o g SEArT
demo
help
lookfor
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M kLB L (Script) e slbl-1Y-)

wwaze ¢l a4 55 o g Glejes jshay jgiws sz sl jolaie
Del oo oolaiwl e slelils |
Sl M Sgy (5115 a2 L oy
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it slehlé sl Jolhe -V )T
lie Kialig jo wa> LB 0,5 50 )
File>New>m-file
5% B o e ol jgias 3 8 ol LT
Foaseie ol b B (3,8 053 LT
File>Save As...
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o b S gl g -V -IY)
L Q)Lc‘ 631-? 5O ‘).;‘ ‘olj oW Ls_élf (SR J.,l.e S L_g‘).?‘ L_g‘,g
sy |, ENEEr ols 00,5 b
S e S5, LM bl jo ool iy S deli p e oo ool 511850
Al dples oold
samplel.m b, :Jts
% SAMPLE1: A Simple m-file
n=10;a=2;b=4;
c=n*a’~3/b + 3*n*a”r2/bA2+6*n*a/b~3

>> samplel

C=
29.3750

Oleial Jiria ol &ai b ule



MATLAB Lol cleaS5s: 5] Las

M LSLQ‘LB 4o J..»..Q.,o Q‘)s.lwd 9 é.:‘a.: -Y-\¥V-)
) e 4l So b ke S jladie g5 ol ISP(X) &b )
: Jlo

>>n=10;
>>disp(n)

10
>> disp(‘This is a string’)

This is a string

Oleial Jiria ol &ai b ule
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M LQLQ‘L[S 9o m C)‘)}Lwd 9 é.:‘g.: ~F-1¥-)
(699,93 e U lude 28,5 ol X=INPUL(S) &b .Y
: Jtoo
n=input(‘Please tell me “n” value: )

Please tell me “n” value: 10
n=
10

Oleial Jiria ol &ai b ule



MATLAB Lol cleaS5s: 5] Las

M lbLl o abe Oljgws 5 mlgi -F-1Y-)
Il o 0 CBg0 LBy :pAUSE jgiws LT
pause
pause(n) % n seconds
: o
%SAMPLE2: Enhanced Samplel
n=10;
a=input(* “a” value= 9;
b=input(‘ “b” value= ‘);
c=n*a’~3/b + 3*n*a’r2/bs2 + 6*n*a/b~3;
disp(‘Please wait 5 seconds only!);pause(5);
disp(‘Press any key to see answer.’); pause;
disp(‘ "C” Value is= ); disp(c)

utg_h.a\ ‘_,’.“la_ua o&;ﬁ.\‘d-‘f\:\.\k u,u\_xc.
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15l 50,5 )15 5 sue &G aS o gin (glael p V=Y oSS
‘)).:) u)L..c ‘QT)‘ oQLSL.w:‘L:AJ oﬁ}SX (obc\.:ng)a
228 goled cawlio s LY Jlade g oS ailxe
y=x"3 + 3*x"2 +6*X + 6;
oS 1l ST MATLAB el o> 50 aali s b ol b

S 1211, 5g5 aab s MATLAB S0, 5l esliz L
s trace

uL@Jm\ L;\x.ua bti.m.\\.ﬁ—@g.\la u.u\_tc



MATLAB Lol cleaS5s: 5] Las

oasls 5 LhB L 0,5 15 1 b Cg e -1 ¥

et Ol ygiws 51 as
sl 3l il g s icd e O
>>cd
C:\Matlab\Work
>>cd C:\MyDir
>>cd
C:\MyDir
S35 plo slaaslt 5 lehB b les il jores O
: LB (05 Sbhsisdelete .o O
>>delete samplel

Oleial Jiria ol &ai b ule
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LQ‘-\J‘)F" ‘ng J..aj

al,] ol -V Y
allsbal gleds,

[ 15, ) odle loslanully )

» Ceodle 5l eslal b

logspace . linspace iy ;l ooliial L
392 sldg, 5l oS 5 ool b

-‘6 -4 "

Oleiial Siria o8l anh ule
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[1 5,5 oo 5l oolanal b ayl,T sloxyl =V -V -Y

QW@OQLQA.«»‘

: JUs

>>a=[1,2,3;4,5,6]
a=

123

456
>> b=[1,2,3,4,5,6]
b=

123456

Oeial Jinia o8l cuida (e



LQ‘U‘)F" :‘ngd J.«aﬁ

[1 5,05 oo 5l oolinl b ayl,T slog =YY =Y
o F alols S Sedle @eo,genter 31 Cdle glou 1SS

: s
>> c=[1 2,3
456,78,9]
cC=
1 2 3
4 5 6
/ 8 9

u\.@m‘ LFSM bm‘d-@;\_\k u_u\_u;



LQé\.s‘)F" :{ngd J.«aﬁ

1 cedle ookl b aglT slou! -¥-)-Y
el sl asl asls KuSo b o alaly a1 S5 olic a5 adlge 1o
3,5 eolatwl 1lg¥ o g,
1wl 5 Oyga jeiws ST S
ArrayName=first : step : last
28, sales I 4T cbu Y Jlade wet B3> STEP 51—

e e asl e Step wb sl first 5l sse.5 last 51—
A aales o5 bl b & gan]

Oleial Jiria ol &ai b ule
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ol =17 e 5l oslaial b agl,T slow! -Y-1-Y
-l

>>x=(0:0.1:1)* pi;
>> y=sin(Xx);

>>7=1:5
7=
12345
>>t=5:1
t =
Empty matrix: 1-by-0

Oleial Jiria ol &ai b ule
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logspace ,linsapce glg 5l sslazul b al,l olow! -Y-1-Y

Sy ooy Ly b Slaall Blyie @l nla all Job s 21y sl polie ail)fL
.Q)s‘
ArrayName=linspace(first,last,length)
: o
>>x=linspace(0,1,11)*pi;
>>y=|logspace(1,3,3)
y=
10 100 1000

Oleial Jiria ol &ai b ule



LQC\J‘)T :{ngd J.«aﬁ

598 ol 5l oS 5 5l eolatul b al,T olonl —¥-)-Y
s

>> x=[0,1,2, 4:2:12 ,18,19]
X =

012 46810121819
>>vy=[10,1,7,4,6,-1 ; linspace(0,10,6) ; 5:-1:0]
y=

10 1 7 6 -1
0O 2 4 8 10
5 4321 0

4
6

u\.@m‘ LSSM o&h\q_@;\_\_b u_u\_u;



LQé\.s‘)T :‘350 Jgﬁ

0529 Sl ilo =V=1-Y
st o ple [ ] O
&S oo Sl oals oold slal b a5 o 5l S5 :eYye M

ool olal b ol o o o yolie ols a5 L jle o :ONES M
A"SLSA QL?U‘ 0y

A5 o oboul ool ools sl by o le S ZEFOS

o3lo slul s eSS mu e b pgadly polie b w5l S5 : FAN
A"SLSA QL?U‘ oy

oolo slul s Jlo 5 395 b ol yolic b o jle S :Fandn W

uL@m\ L;\x.ua btg\.m.\‘.l—@:}.\k u.uLIQ
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aalol =05 g (Sloms Slo =F-1-¥

;L

>>ones(2,3)
ans =

1 1 1

1 1 1
>>ones(2)
ans =

1 1

1 1

a5 pialesl pBog ) (599 wls ple i pes

Oleial Jiria ol &ai b ule



LQC\J‘)T :{ngd J.«aﬁ

LQc\.s‘)] SS9y » LS@L’) uLs.Lo.C -Y-Y

_I+IAI/I\I* “\:’.‘)T_)J&W‘Qlfrlﬁc =
',+,.A,./,.\,.* Lg),a,&uu..o.c .Y

°°‘°Gf:-‘593‘~’~*€) = + I & I/I\I *L_s-“’ﬁt"uu-“ Y
(o salg=

Oleial Jiria ol &ai b ule
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sl - Il ol Sldee —V-Y-Y

Sldae lgf o ool cdie oL, sl Soe 5l oslaul b
Slo slout ) 4l - ISl sk

e

>>x=[123;456; 7 89];
>>y=2*x+4

y=
6 3 10
12 14 16
18 20 22

Oleial Jiria ol &ai b ule



oyl pgo o

Gl 90 o g paie (2b; Slles -Y-Y-Y
2Bl am o L bl g0 Wb jolate cpu
s
>>a=[246;356; 10-10];

>>b=[-100;211; 00 3];
>>c= (2*a ./ (b+1)) .~ 2

C =
Inf 64 144
4 25 36
400 4 O

el Jria o8kl ula e



LQC\J‘)T :{ngd J.«aﬁ

ot ile Sy oolgdl 5 Y-
g oo oolitul - Eadle 1 s il G solpil 3 auloe sl
: Lo
>>a=[217
45 -1
6, 6, 0];
>>b=a’

Oleial Jiria ol &ai b ule



LQC\J‘)T :{ngd J.«aﬁ

L‘“‘%‘)‘ S99 s@le.) c’:."93 Q%—.’)Li.’ ==X

2o e SO SIN asle b s oY i 08 o Joo i sle S jpa e &l
5 g Jlaie j5iwd SO L Gl o0 (Sl aSl 08 Jlesl w1 SG yolie (59,5
Sgos dmlxe I 11 olic

s

>>a=[246; 356; 10 -1 0];
>>SinA=sin(abs(a) / 10)
SinA =
0.1987 0.3894 0.5646
0.2955 0.4794 0.5646
0.8415 0.0998 0

Oeial Jinia o8l cuida (e



LQC\.:‘)T :‘350 Jxﬁ

1=V (2 0o
Sl 90,55 o )5 SN zaors dae a5 ds g (gl asliy )
M8 X e 0 00405 sl 2I’TIT9° Oy G pais Vo
1220 yiuled 00,5 dcwlxe i abl) S Y polde e 020
y=|sin(x)|*x?
sous N )|A.&Aﬁog)l.c45&¢.mom.£36)3b ‘) 69_9 d.,olj).g Y
o3 180 sam i ;599,85 )5 1) 50

d l.:)J);S,Lg,olbeolzn'ng * Q.:.g‘)x)‘dﬁw
o les aslo

uL@m‘ L;\a.ua bt;\.m.\‘.l-@;t.\k u.uLIQ
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sl ) ezl il -0-Y
m2=m1(L@w¢.s| S elall, b wasl Lg!c\i\j)
>>a=[123

456
7 89];
>>kl1=[1,2];k2=[2,3];
>>b=a(kl,k2)
b=
2 3
5 6

Oleial Jiria ol &ai b ule
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—anlolal )T 5l i | senl —0-Y
>>c=a([1l 2 3],[1,3])

O O W

=a([3,2],[3,1])

N\

Oleial Jiria ol &ai b ule
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—anlolal )T 5l i | senl —0-Y
>>e=a([1,2,3],2)

e=

2

5

8
>>f=a(1:2:3, 3:-2:1)
f=

3 1

9 7
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—anlolal )T 5l i | senl —0-Y
>>g=a(1:3, 1:2)

g:

1 2

4 5

/7 8
>>h=a(l:2:3, : )
h=

1 2 3

/7 8 9

hinal ixioa st anh (il



LQC\J‘)T :{ngd J.«aﬁ

—anlolal )T 5l i | senl —0-Y
>> k=a(:,:)

N A~

2
S)
3

O O W

>>|=a(1l:end,end)
|=

3

6

9
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—anlolal )T 5l i | senl —0-Y
S0
>>n=a([111], :)
n=
1 2
1 2

1 2 3
>>m=a( :, [3 33 3])

3
3
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>>p=a( :)

p:
1
4
7
2
5
8
3
6
9

—dalol-al, |5l szl sl —0-Y
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N~ M~ M~ N~ M~ MMM~~~
© © © © © ©U ©U © © o©
0 IO 1 10 un wum wumw w wuw w
< ¥ Y T YT YT YT T
MO MO MO MO O M M MO 0O oM
AN AN AN AN AN AN AN &N N N
_1111111111
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LQ‘U‘)F" :‘ngd J.«aﬁ

—~

Ll 5l Lise B> —F-Y
ols o iz Bl ]y (68 omile Ulgie Al St cisy Bds jslaia
>>a=[1 2 3
2 5 6
7 8 9]
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LQC\J‘)T :{ngd J.«aﬁ

1155 G oma-Y-Y

find yaiod Elel o AlS o Foo ol byl o as b o ol Bl gl
(S oo oyleds St Oygar by yolic jaiws pl) 0,5 colai]

>>a=[1 2 3
4 5 6
7 8 91;
>>k=find(a >5)
k=
3
6
8
9
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—aalob-all 5 (g omiaa—Y-Y
>>b=a(k)

O O 0 N
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LQC\J‘)T :{ngd J.«aﬁ

—M‘Q‘—c\.ﬁ‘jﬁ)’ ngew—V—Y
o o )leds o 00 5 S (9,5 HeoS )l g0 b a5 90 o find S

wils S oo 5l 1) polie g g
>>[kl,k2]=find(a > 5)
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W W N =
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2551 Cawds | 41 S slal o5 e SiZE g length ol jgius 5l eslial b
S5 69y 2 ST g ls S o 3L 1T jolie slaws b 00 G o G g5, 2 STIENGEN oo
10,8 oo b a1 55 55 005, 510 G Sl
109 08 1 0 ) sladig,y 4 Xlgl o g 00 T s Bllasll size 5w
ils S sailo 1y o pile (250 5 Jsb gd 00 IS (69955 lesS, I o L 51
oy ALY LY 0 legS )T aSs ol 098 00 G (50955 (lesS,l g0 L ST M
Ao )5 caib 1) e Sle Sledgiw b b ylass sluws
o0 S5 5l el gt g slas Slasi gl 00 I (2,5 eSS L ST
$ls 5 a3l (6 paic 90 (5l
el G ple Ge g yla Slasi d 00 IS (255 JlesS )l 0 L ST
Sl S o 5k pgs 9 Jol lesS)]
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>>a=[1 2 3 4
5 6 7 81;

>>sjze(a)
ans=
2 4
>>[r, c] = size(a) >>r=size(a, 1)
r= r=
2 2
C=
4

LQC\J‘)T :{ngd J.«aﬁ

~aolol-alyl o5lasl ~A-Y

s

>>c=size(a,2)
c=
4
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LQC\J‘)T :{ngd J.«aﬁ

—aslol-asl, T o3lasl —A-Y

>>b=[1 2 3 41:
>>|=length(b)
|=

4
>>a=[1 2 3 4

5 6 7 81;

>>la=length(a)
la=

4
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o ple Oldose g 2lg5 1pgm Juas

lea:} SYolro oliws J=-\-Y

Ole oo (axlp cdin 10 s e i g O o Sllee sl oolaiul L
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o ple Sldee g polgs tpgw  fuad

dolol- oz Yolso ows = -1-Y

X+ 2y +3z =366
Ui

4x+5y+6z =304
/X+8y =351

J/\

>>a=[1 2 3 >>b=[366 ; 804 ; 351];
4 5 6
7 8 O0];
>>x=al\b L >>x=a ™ (-1) *b . >>x=inv(a) * b
xX=
25
22
99

u‘.@m‘ L;\a.ha b&;u‘d-@;t.\.b u.u\_u:



o ple Oldose g 2lg5 1pgm Juas

s yilo ey 5l golaws -V-Y
AS o dwlore |y 0 e G pile SO weSae 4PNV M
21,5 oib |y o il SO Jol a8 slie sqoe Trace W
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o ple Sldos g plgs tpguw Juas

Sewds ) Dl Cn e 5 9 S 1) py (o Vol olSins YIS

(X+2y+3z+7t=4 9 59!

OX+7y+222+32t=5
08x +5y—-23z+t=7
32X+2y—1752+23t=1
22X+2y+3z2+1=0

clin plag L1y olfiws rwly 9 0,50 0I5 5l e Y oleo olSiwo

uL@Jm\ L;\x.ua bti.m.\‘.ﬁ—@g.\k u.u\_ls
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Lg‘d.la.g‘)gdﬁ.’a.;oﬁ;lfl.o.c TP W=t

s - Lfalse strue sk jolie Lolol a5 Sllec i =

slakly oo Slos V¥
rasloads oy e cdie o g Lg‘c\.b.g‘) LSLQ;LO.C
< = > = —=— ~ =

4 7

u‘.@m‘ L;\a.ha b&;u‘d-@;t.\.b u.u\_u:




Lg‘d.]a.g‘)gsﬁa.;.o&l,,.l.o.c TP W=t

alyl g8 aulio V-V -f
S, dwlio oSG b yaie 4 ypaie |y aly] 90 le5 o slabal, slo Soe T oslannl L
bls sl gl gV Jlade caiiS o §ao ool S3 b0 o aS bl sl a
Dol o oile 55l e ade
>>a= [112131415];
>>pb=[10,2,13, 4, 8];
>>tf=(a == b)
tf=
0O 1 0 I 0

Y g polie wlgs oo ki (09 wales (lOgiCAl) bbis go5 5 e SO EF s
S o3l 00 L LT oo jate 08 s el plgin 000K 095 40

el Jria o8kl ula e




Lg‘d.la.g‘)gsﬁa.;.o&l,,.l.o.c TP W=t

ot 52 b sl 5 ali Y1
159l o delie Sae SO L )yl jolie ol s ol o

>>a=[1,2,3;4,2,2;1,10,0];
>>t=a >=2

t=
0O 1 1
1 1 1
0O 1 0
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LQ‘AJ"-.") 9 60.’4:..,0 &_JLJA.C :ﬁ)Lq_g- J,a_g

Go gol> byh 0 a5 w il So g pele glmal: e

>>a=[1,2,3;4,2,2;1,10,0];
a=
1 2 3
4 2 2
1 10 O
>>a4 =a .*(a>=3)
a4=
0 O 3
4 O 0
0O 10 O

u‘.@m‘ L;\a.ua bm‘d-@;}_\k u_u\_u;
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N ool ogy0 Dlped o5 s o glaelip N -F 2SS
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59,5 S I MNF3) o 5le G &g | geiils
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>.O.'a~o w sl ,S.Lo.c/ -Y-¥

a8 aies i o ghio glo See v 5 | 5 & sl Klae
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Lg‘d.la.g‘)gsﬁ.’a.;oélfl.o.c TP W=t

(dolol) dlaia gl Sloc-Y-
;s
>>a=1:9;
>>t=a>3
0O O o) | 1 1 | 1 1

>>f=n~(a>3)
1 1 1 0 O 0 0 O 0

>>tf=(a>3) &(a<=7)
0O O o 1 1 1 1 O 0

Oleial Jiria ol &ai b ule



6‘4@‘)96&’4@&[*1&; TP W=t

ihats 5 glabul, wlys -Y-F
B )..q Ls:u‘y 9 Ls.o.‘a.«.o 9 Lg‘c\.ba‘ LSLQ)SJ-Q& 5 09>L9
o be oS 5,10 0959 yslais
all (x) b3l e sglusl o p S ol oled 4SS 90,0
S5 so 5k ¢ Djganl pe 0 9 ) ok

any(x) b gobal o SO ol SO Blas a8 gm0
JJ‘Q;LSA )LJ = u)gaa.u‘ )A.g 399 ) )L&.O.o ML}
XOF(X,Y) L s laxl gl
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Lg‘d.]a.g‘)gsﬁa.;.o&l,,.l.o.c TP W=t

dalol dlais g gladal, aoley —V-¥

>>x=[110];
>>y=[01 0];
>>tor=X | y >>txor=xor(x, y)
tor= txor=
1 1 0 1 0 0
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Lg‘d.]a.g‘)g‘sﬂa.;o&lﬁlo.c TP W=t

dalol dlais g gladal,y algs -Y-F
: Lo
>>a=[1110];
>>t=any(a) >>t=all(a)
t= t=
1 0
>>a=[3 2 4];
>>t=any(a==2)
t=
1
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*
. * . S
u.».o .r@?w M
* 0.0

L_g).’l.ﬂ)lf L_gl.c'ad.’l...f})—\—&
:og.;bso solaul Coadke )‘ L 30 6)35‘)15 Lchbc\;;;’;a) ETEe T 6‘)‘3
: Jlo
>> s="This is a character string’;
>> size(s)
ans=
T 26
Sigd o ailil s Sle loim 50 o ST laand ) Cdie jo :aiSK
Sy oo Dgme g flo paic S SILE a4 ok

Oleial Jiria ol &ai b ule



*
. . <
wc .rw M
* 0‘0

abs ol e xS1)5 Sl oS ialei-Y-0
e ADS 2 5l g3 oo ans, S (Sl 05 Lioles (5l
5560t
>> s= ‘Hello’
>> u=abs(s)
U=
/2 101 108 108 111

Oleial Jiria ol &ai b ule



*
. . <
wc .rw M
* 0‘0

A 4 (Sl oS fas-T-0
IS esliul ChAr b 5 ST & Sl oS Jas ol
>> s= ‘Hello’
>> u=abs(s)
u=
72 101 108 108 111
>> sNew=char(u)

sNew=
Hello

Oleial Jiria ol &ai b ule



*
. . <.
w orw M
* 0.0

aill, o sl Ls -Y-0
LR LgLQ,».:JSLo Soobe ‘946@ Ls.ﬁéoul’;,oé)lf‘ lSL;Lam)Lg
Q;JL«c\LM I 2l ldee ol o Do 5,5 s,
S eolaiiloyge ) all, Sulos Cdie &jgan! o
OB 4
J & 551, el
>> s= ‘Hello’
>> slnv=s(end: -1:1),

>>disp(sinv)
olleH

Oleial Jiria ol &ai b ule



*
. . <.
w 'fw M
* 0‘0

(Js! 0906 ST Slops 5l slou-0-0

sbulasbe ;oL ] odle 5 ol oo 65T o le SO sl (6l
Slsgiw olaxs a5 ogi cds wb Ll o 5 sslaul gooe sla o 5o
ol Soluw Hlaw o
>> sm=['This is first line’ ; ‘This is second line’]

?27?? Error using ==> vertcat
All rows in the bracketed expression must have the same

number of columns.
>> sm=[This is first line > L= Lol s J& aol

“This is second line’];

Oleial Jiria ol &ai b ule



*
. . <
wc .rw M
* 0‘0

(P33 53,8 2SS (slgom o Sl 5-0

il o Char ol oslinn! 6 2SS G 5le SO obul ol e 3,
>> |[inel="This is first line’ ;
>> |ine2= ‘This is second line’;
>>sm=char(linel,line2)
sm=
This is first line
This is second line

Oleial Jiria ol &ai b ule



*
. * . S
u.».o .rpw LJ.«QS
* 0.0

sl o o INpUt &b sleslaul b (055 sl and, 5o 53,5 ol
30 0 Gl e by B9, 90 aeli

LSy )83 ol s el U (pl sleslatnl Jgons uf‘ﬁ)_u‘ﬁ‘ Y9
by Wbzl e 50 Sosanl 1o e e S0 09,5 GlesS T S
2l )1).%‘ : J=lo sl

o aS ol o S pgs oS, T SO LINPUL &b 5l eslanl g 3o,
S ST oo oS o A as) plam 1) 55 (63g,5 cdie &5a0)]
= =

u\.g_h.a\ ‘_,’:la_xm o&;ﬁ.\‘.ﬁ-‘f\;\.\k u,u\_xc.



*
. . <.
wc .rw M
* 0‘0

—c\,ob‘—duol.?).g LS‘J"‘ e 3 45 L‘).’;_éjf—\/—&
s

>>s=input(‘Please answer Yes or No: ’)
Please answer Yes or No: ‘No’
S:

>>s=input(‘Please answer Yes or No: ’,’s’)
Please answer Yes or No: No
S=

No

Oleial Jiria ol &ai b ule
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u.».o .rpw LJ.«QS
* 0.0

oazis, b S alsi ple —A-0

SErcmp(s1,52) : wis o jb + ygan] 80 5 ) aiil (L, 4 90 455 500

upper AERVL PP PRV IS SR TRE PRCP PR I Vv RS VTR - PCRP o N
lower HRCL SUP I FIVERE CL SIS PUCSPUS [eP LIS VI PYCS DY
num?2str P GOAE ALl A dde fiaS

str2znum PO (GONE AL,y fiaS

mat2str iy 4 olael 51 e il oS

eval Paslh oad oo ad, O e a5 e 5l Sbeyd 6l o]

s 0ails 53k aii; pgd i o aS el cpl o MAt2Str LU L NUM2SEr b oglas s O
cwleval ol bug |l LB

u\.g_h.a\ ‘_,’:la_xm o&;ﬁ.\‘.ﬁ-‘f\;\.\k u,u\_xc.
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L)M orw M
* 0‘0

ndalollaals ) LS mles wlo -A-0

>> a=input(‘Enter <a> value=9);
enter <a> value= 12
>> disp([‘You number is’, num2str(a) , * . Thank
youl']);

Your number is 12 . Thank you!
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S9) S5 9 6 S pead i Juad

3,5 peply> oo 1,5 glaadl> gl 5 (b pd SMea 3,90 )0 Juad ]y
for dal>-\-¢
il 55 O ygar i yo fOF ail> IS5 JSCs
for x= 4l
Sl ghws
end
5SS e 50 g ab aalgs S5 ead atie wll Gldgie slass 4y 598 ddl> & jgaisl o
Gl aSS g0y ol solaiw] b dals 6y o g a8, 13X e o lyl ol slasein
28,5 walym 13X paie o ol Gl yaie SG L e all b S

L5 00,5 oy b (Sow oo U i o bradls 0 )15 5l Clie s ilo slgolilei 4 axgi L1 S5
B4l (6 idion sl cwng 05 ) 5Lo g gl co Aeli p gl ol S Cel IS
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S9) S5 9 6 S pead i Juad

forn=1:10
x(n) = sin(n * pi / 10);
end;
for k=[1,2,3,7]
x(k) = k+1;
end;
>>X
X=
2 3 4 0 0 O O 8

—aslo-for ail> -\-¢
;s

Oleial Jiria ol &ai b ule



S9) S5 9 6 S pead i Juad

. While s> -v-¢
a5 IS ol byh o130 U s s b SO earlgsn a5 60 )lee o
ool 113 O j0a WhHIle ails IS5 IS8 .0 o oolisnl adls ol 5
while L
Sl ygiwd
end
A dwles WSS ol L8 s eas SO b L aSoley U 398 aals

uL@m\ L;\x.ua btg\.m.\‘.l—@:}.\k u.uLIQ



S9) S5 9 6 S pead i Juad

—alo— While sl -y-¢
;b

t=1,;
while t ~= -1

t = input( * Enter a number to continue or -1 to exit from
this block: “);

end

Oleial Jiria ol &ai b ule



S9) S5 9 6 S pead i Juad

—aolo While ail> -v-¢
;s
Seen dmliee ilie ,o liel abaii Slovle 85 o YL Jls oyl 4o
Epsilon=1;
while ( 1 + Epsilon ) > 1
Epsilon = Epsilon / 2;
end;

disp(‘This is the smallest floating point number in matlab: );
disp ( Epsilon);

}\J.ab)ué.ao&&@.?diL;\leéo_xw):iggégl}q;ﬁ)oeps 0y s AST
NGV DY TRV SRS\ R V3 RUSWWRY Epsilon plpgs sae plaS g drles 55,50 SO

u‘.@m‘ L;\a.ha b&;u‘d-@;t.\.b u.u\_u:



S9) S5 9 6 S pead i Juad

if-else-end sL. -v-¢

Sob slesd [l (LSe) ool byd 505 5,85 &j90 50 dez vz b S5 peplszn o5 2
il 525 S ygar yeiws ol 5l ooliiwl (IS ISE 0iS o ooliinl If
if Vv Lo
Sl gws
elseif v L,z
Sl giwd
elseif

else
C)‘)sl.wé
end;

uL@m‘ L;\a.ua b&n.\‘.ﬁ-@;t.\k u.u\_u:



S9) S5 9 6 S pead i Juad

—alok if-else-end sl -v-#
:Jts
Epsilon = 1;
while1 > 0
Epsilon = Epsilon / 2;
if Epsilon + 1 ==
break;
end
end
& ypan! o .cwsSs |, for b while wil> < olg o break jgeus bass O
8l sales aslol ddls 1 ow jeiws iass jlasl 5 gl

Oleial Jiria ol &ai b ule
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s= input( ‘Please enter a scalar value= ‘);
if length (s) > 1
error(‘Error! Your input isn”’t a scalar!’);

end
a= linspace( 0, abs(s), 100);
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fft , ifft , fft2 , ifft2 o, 5, s

>> X = fft(X) 4,5 Los

>> fx = fft(x,n) aais N o 4,98 Los
>> fsx = abs( fft(x) ) a,s b

>> psx = ( fft(x) ) .~ 2 Olg b
>> x = ifft( fx ) 4,98 hoss eSe

>>X =0fft( X, N ) i N sa,8 has Se
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>>1=0:1/99 :1; .L; b,

>> y=sin ( 2*15 * pi * t) + randn(size(t));, <L X
Sl oads oS 5 g JiSw SH L &S 35,210
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>> plot(t , ¥); oloj oy yo Jufow Sl Jloged oo,

el Jria o8kl ula e
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>> fy = abs ( fft(y) );
>>f = linspace(0 , 99, length(y) ); 5,339 akal, -l o
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>>plot(f , fy) A58 b Jlogel

15 Hz
99-15=84 Hz
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>> x= linspace(0,2*pi , 30); y= sin(x);
>> plot(x,y);
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subplot( m ,n, p)
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dalol S 0y SO 50 Tiome Jloged wiz pu, =V-1

s
>> x=linspace(0,2*pi,30);

>> subplot(2,2,1);plot(x,sin(x));
>> subplot(2,2,2);plot(x,cos(x));
>> subplot(2,2,3);plot(x,tan(x));

>> subplot(2,2,4);plot(x,sin(x)+cos(x));
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xlabel, wly 5l olg oo Jloged lp Hlsie sbml g b jgome (6,108 con> 1 jshates
2,5 oolaul Ylabel , title

>> xlabel(* _w. a3, 59);
>> ylabel(* . as, X);
>> title(* e axs, %))
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>> grid on  wS o JWd 1, glass el
>> grid off wsie Jbs e, glass >
>> grid a3 oo pss Jd 4 Jld 8 5l g Jls e a Jld 5l e
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Swo,in 10 Jlogel win pudletn a5 g0 ;0 00,50 IS 0y
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>> figure;
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ISged 4o e (09580 719
25,5 a8lal Jloges 4 1, e oyles oo GEEXT g TEXT wolgs 5l eoliwl b
>> text(X,y, o as))
>> gtext(’ . as))
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legend jgus i odle bl o438 -Y-9
==

x=linspace(0,2*pi,30);
y=sin(x);

Z=C0S(X);

plot(x,y,’g-.”,’b-");
legend(‘sin(x)’,’cos(x)’);
title(‘Sin(x) and Cos(x) curves);
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Sin(x) and Cos(x) curves
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axis([xmin,xmax,ymin,ymax,zmin,zmax])
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e jo glalozaia SO o eV
Sg oo i yai Syl o G g Gladesr s SO i o
. e
>>p=[1230-5]= P=X"+2Xx>+3x*+0x=5
Slabor 3z slaady, (8L -V-) -
23 5] Cans 1) lales ais SO gloain, olg5 o roots b sheslaat b
e
>> r= roots(p)
p= -0.7202 + 1.7518i
-0.7202 - 1.7518i
-1.4930
0.9335
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omlraiy 5l eslanul b gladesais S 8L -Y-)
591 s Galwdin; 59, 3l 1) Slalezr iz S lgiee POIY &b 5l oslizal L
s
>>r=[1; -1];
>> p=poly(r)

p:
1 0 -1

SF 0 S Siea Bb glder Kz lealy; ez sz 55 D Al

u\.@m\ LFSM bm‘d-@;\_\k u_u\_u;




LQﬂihx?AL?:¢&x>LLaé

Lo lalo> L oo =YY

5,5 solawl CONV é.gl.? = 0\9364, Sl s> 90 o jelaie

: Lo
>>a=[1234], b=[149 16];
>> c= conv(a, b)

CcC=
1 6 20 50 75 84 64
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plabozrdiz @ ,85 3 gaz 0=V -
Jsb m o p 90 (Tl 0,5 50,85 b gex KK L1, jlop 90 le oSl sl
929 g labos aiz 51 (S0 o kS o5 (onlpo b pgy) D50 jo 1A anily

gl Job oo gldlom iz g0 b olo 13 po b plppgo oz o1 5l
e

>>pl=1[45 3 2]
>>p2=[05 2 0]
>>p_sum=pl+p2
p_sum=

4 10 5 2
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50 &b ol 188 i 0S5 1) lalezaiz 50 ol o AECONV &b L
g2 3olg> i odilenSl (098 9 Coond 5 gl &S 055 o (295 bS]
>>a=[123456];
>> b=[ 2 3 4];
>>[q,r] =deconv(a,b)

q:
0.5000 0.2500 0.1250 1.3125

F =
0 0 0 0O 0.5625 0.7500
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: JLs
>>g=[162048 69 72 44]
>> h= polyder(g)
h=
6 30 80 144 138 72
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polyval b jl abhis six b G o Glalozais polie deulo glaia
.o)S solas ] Qbs‘so

: s

>>p=[14-7-10]
>> x=linspace(-1,3,100);

>> y=polyval(p , X);
>> plot(x, v);
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polyfit ot sove 3351V
355) oy 1 alaii ais o_ws S (e Ol POIYFIL &b 5l oslanl L
ez et ]y |y 393 Sn 5 e glelar sz ol o)
w‘ ).3‘) u)a.«a.g (':>L’ U"‘ oolaz! ‘515 Jiw dq‘d;u;o
P= polyfit(x , y , n)
Ll ol glalozaiz a> 0 N g pglae LG Y ¢ X calasly -l o aS
: Jle
>>x=[1257];, y=[10 22 48 75];
>> p= polyfit(x,y,1)
p:
10.45 -0.4396
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Interpl b :gum S olsg,s -Y-1)

s 59y y adel bl 093 Legy) omie (S3lp j0 a5 Cal G (S5l b Slogye Sl
Sl oslaiil 5 00 i 5l oy adsl blds ¢ Slag o jo Ll oilas 18 oals 5l
ol 55 Sy INEEIPT Al oot IS IS8 il o obigyo
y_new = interpl (x, y, x_new , ['method’])

og,d 1Y polie sl a5 sl X5l g ppolie X_NEW eyl bl X, Y alal, oyl o a5
)JQLQ.A )‘ ‘_;i: J..a‘yu;o mEthOd ML’SA o S,L.:g)d ).n)l.o.‘o y_neW 9 d..’g.w
sl )

‘nearest’ , linear’,
‘cubic5v’

spline’, ' pchip’, cubic’,
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: Jo
>>h=1:12;
>> temps = [5 8 9 15 25 29 31 30 22 25 27 24];
>> plot ( h, temps); % ses 00, 5 s olig,e dec
>> h _new=1.5;
>> t _new = interpl(h , temps, h_new)
t new=
6.5;
R PARY
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—dalok gam SO oldg,o =YY )
JL.a M‘d‘
>>h new2=1:0.1:12;

>> t new2 = interpl(h , temps, h_new?2);
>> plot( h, temps, ¥, h_new2 , t new2);
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>> t_spline = interpl(h , temps , h_new2 , ‘spline’);
>> plot(h , temps, *, h_new2 , t_spline);
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INterp2 ~b :gox g0 olig,s -Y-))
b sl IS S
Z new = interp2(x, y, z, X_new, y_new, [‘'method’])
sl 5 pelie 5l S wilg o Method
‘nearest’, linear’, 'spline* , ‘cubic’
: Lo
>>w=1:5; d=1:3;
>>t =[8281 80 82 84
79 63 61 65 81
84 84 82 85 86];
>> W new =1:0.1:5;
>>d new =1:0.1:3;
>>t _new = interp2(w, d , t, w_new , d_new’ , ’cubic’);

Oleial Jiria ol &ai b ule



*

9y 9 (oo il el Juasd

anlol = oy g0 oldg,o V-1

>> mesh(w,d,t);
>> figure;mesh(w_new,d_new,t_new)
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Ll Lo Job o2 Jlopan a4 S

SO b ply gl b ;8 SO o) L
x=t
y= sin(t) teR
z=Cos(t)
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aolol- olas slpos -V-))

>>t=0: pi/50:10*pi;
>>plot3(sin(t) , cos(t) , t); xlabel(‘sin(x)’); ylabel(‘cos(x)’); zlabel(‘x’)
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J=imadjust(I , [0.3, 0.7], [0 ,1]);
subplot(2,2,1);imshow(I); subplot(2,2,2);imshow(]);
subplot(2,2,3); imhist(I); subplot(2,2,4); imhist(])
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I=imread( tire.tif");
J=histeq(I);figure;
subplot(2,2,1);imshow(l);
subplot(2,2,2);imshow(]);
subplot(2,2,3);imhist(I);
subplot(2,2,4):imhist(]);
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I = imread(‘eight.tif’);
J= imnoise(I , ‘Salt & pepper’, 0.02); % ;s ;043
K= filter2(fspecial(Caverage’, 3) , J) / 255; % ,SlL. L3
L=medfilt2(] , [3, 3]); Y% <l L3
subplot(2,2,1); imshow( I ); title('Initial Image’)
subplot(2,2,2); imshow( ] ); title('Noised Image’);
subplot(2,2,3); imshow( K ); title("Mean Filter’);
subplot(2,2,4); imshow( L ); title("Median Filter’);




Initial Image

aslob pgai (¢jlas 9 RIGI-V V-V
dolol pgal (6 5bute
dalol 1Kl L8 g aile 2l auglis : Jlo— g5 B>

Noised Image




Syl las 55, ¢ Slilas -V YT

Abu S Sl pgai Ul S dsgerme ) 6 ub pslal 65y p Sliles 4 ST
G yiou o ) donae plcpgal ilo e 0 g 0l palal Coenl
losgas 4l

ol sy aS Sgus oo £S5 S pgal 4 (6ol poal b 4l S A 4Sles
g 03 0dl el iglal Djgan b g Dab polal &g wSlg o0 500
Dg dlez o g0 o Ll S ail o yile poo Gl 0 aigd 8,




Sl polal 55, » Sllee AVAAY

S b polal Sl
055,50 1 S o 03l IMSNOW &b 5l 55 6,0l polas Sisles ol

a5k oad il g4 51 ST IMSNOW(IM) : 5 3 03l 2ol g6 51 pgas
A3 sl 00 G IMShow(l ,map) : 53




Sl polal g5, » Sllee SIVNY

Morphological Operations . sl olles

s Ol 1 ol g ool Jleel (5,00 polal g9y 2 aS 0gd e 4 Sllee 4 6,5l Sldee
Sldes 518 alo o SO Vgone Slloe ol ol g0k pgad S Job a0 memai b g
5 S 5T o a5 col Slles Sl 33l Sllas 1 jslaie gioe pbsl Sl S5l
33,8 oo dpwle poal ol Colun b aore Ml 04 zlyoeiul 4 gal

oS e aS 0l aales ools =0 Lol o e 3l g Slam dalol jo Sllee opl b
S8 Sleloe -
il lbes -
SoesS Slles =




aolsb s 5l pslad 53, p Slles VYT

wls-Morphological Operations ¢l olles

(Dilation & Erosion) L. s 5 ol ollec

S St e o Tt St Sat it oab o oot Sther st St bher s
05z SHlse Ae @bl pyai Solas (blai el (S Joe il 15000 5 (oo Jusoy
e g0 ol 1S Mo 0355 rmeal wewl ool > Cgllaol aslinl oo Jlecl b 5595 50
ol L oled a5 conl & 90 oy Salidl s Jlesl o, s80L 000 5 Jate 50050 4 poad
Db st (o p 9550 abals B G leen 1 (S JBlas 4SS50 0 00l ()0 g
Sle dalez (b ol &jgan] 18 )0l dalss ddtu 5 55050 adals

Syl poal alerl LlE Yoore Sliles onlyo conl ol Sllee S lds inla 3 Slles
sobed Mos oy siales oS50 oS aim b G ojlail 4 55 paai Il ple 5 ad o0 Bi
ol bl obew T Sl B laon 51 (S Jilos a5 550 50 00 (o9 g9l i bIES




wls-Morphological Operations sl olles
dalob jiolw,8 g ioliel ldes
Sl wed oo gaseie (MASK) Sile o 5l S gy baslaos Sbesl 5 Slaon oladl
JJQJMUML»)B l; uw‘)ﬁ‘ u_JLlo.S— LS‘ﬁ )y J)s.oc\.lamcbw Q L_saol.o.égoa.w 00 4 )lig VY
2555 18
sslaul iIMerode b 5l il $ ollee ol g iIMdilate ob 5l e o (il oldee ol 5
Sls alsl Ll o s DWMOIPH 5 IS 2l jlesleiul L 1) Sldes 0,8 4> ST .08
il 53 O ygea ol cplslestanal IS™ o )8
bw2=imerode(bw1l, se);
bw2=imdilate(bwl , se);




aslobs b pslad 59, » Sllos -1V-NY
wls-Morphological Operations ¢ sl olles
Jle— ol 3 5 Gl Sllee
bwl=imread('circbw.tif’); SE=eye(5);
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imshow(bw1); figure; imshow(bw?2);
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se= ones(40 , 30); bw2= imerode(bw1l , se);
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imshow(bw?2); figure; imshow(bw3);
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imshow(bw1); figure; imshow(bw2);




Sy IS SO Jolds pguai oyl cawl caws jorgb g4 siflower.tif sb 4 gpsar V1Y ST
P AS St g (510l il (o Aoy ST (59 1 e STy 4 S 0 g a8l g 308

O3 M ol & o yilo 5o 15T (sloools g ouilys 1) g8 yguai = I

D1 (slobs syl y 9l 99 30,8 52 (61 VAs ailiwl 0 g s £ 32 (61 1Y+ diliws] v 5l oolisnl b -
bly 410 D929 5 3 g 4Bl eljrl Lo (030 30 9 S5 gl e (Jol yo 45 wis olmb2

byl Mo e S aluwl o> Glp bps SO 31 colivw! Lod LSy Tl (glp i g lecal,
wwsS el 1,m(E,5,2)>120 & m(:,:,1) < 100

2p b1l 55500, glmiwbl pgai 01, S 502

C sl pgai U asled Gy ;5508 b oo )0 (Ao sl ;Sos jlooliinl L1,D2 sb11 polai o
AR

Syl cewasb2 sb11 b1 pola i, U5 lixo g colu g a8l g S p coluo —o

Cawss D2 9D polad jo (paal i CoomYl AlsF a5 o) dshun JunSy s Sliaizio — 9
.3 ,3]

301y 3> & bumo g Colu pouad puled 31 g “9“ g “0” Glosomd b gtext jeiwo ofLé.ml L-)
W2 gwled ol LS



flower.tif
flower.tif
flower.tif
flower.tif

gg 5 o fAbric.tif o6 L ase >l S pear YW S
B il b SOl pgar ol cwl cans o (@rayscale)oas
IS il )8 o S w598 bos 5l eolatul b ST spus i (slael p il o0
2 5 ok 5 el B ol Sl oolail b g (g390e 5 (A8 Cgz 50 jm5e b
b eas ORglesy e Gl 5 oS aubee 1) 39 )b slul ppa

S 55 A )°dp| 7o

o ygl Sy



fabric.tif
fabric.tif
fabric.tif

